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3. Revit ® Architecture : 

Introduction : 

We sure you’ve seen plenty of presentations on how wonderful and 

versatile this 3D Autodesk® Revit® revolution is. You may be thinking, 

―This all seems too complicated for what I do. Why do I need 3D 

anyway?‖ 

The answer is: You don’t need 3D. What do you do to get a job out—

that is, after the presentation when you’re awarded the project? First, 

you redraw the plans. Next comes the detail round-up game we have 

all come to love: pull the specs together and then plot. This is a simple 

process that works. 

Well, it worked until 3D showed up. Now we have no real clue where 

things come from, drawings don’t look very good, and getting a 

drawing out the door takes three times as long. 

That’s the perception, anyway. I’ve certainly seen all of the above, but 

I’ve also seen some incredibly coordinated sets of drawings with 

almost textbook adherence to standards and graphics. Revit can go 

both ways—it depends on you to make it go the right way. This chapter 

will dive into the Revit graphical user interface (GUI) and tackle the 

three topics that make Revit .  

3.1 The Revit Interface: 

In Revit, the vast majority of the processes you encounter are in a flat 

2D platform. Instead of drafting, you’re placing components into a 

model. Yes, these components have a so-called third dimension to 

them, but a logical methodology drives the process. If you need to see 
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the model in 3D, it’s simply a click away. That being said, remember 

this: There is a big difference between 3D drafting and modeling. With 

that preamble behind us, let’s get on with it. 

First of all, Revit has no command prompt and no crosshairs. Stop! 

Don’t go away just yet. You’ll get used to it, I promise. Unlike most 

CAD applications, Revit is heavily pared down, so to speak. It’s this 

way for a reason. Revit was designed for architects and engineers. 

You don’t need every command that an individual designing a car 

would need. An electrical engineer wouldn’t need the functionality that 

an architect would require. In Revit, however, the functionality I just 

mentioned is available, but it’s tucked away so as not to interfere with 

your architectural pursuits. 

Either way, it’s a simple concept. You just need to slow down a bit from 

your CAD habits. If you’re new to the entire modeling/drafting notion, 

and you feel you’re going too slowly, don’t worry. You do a lot with 

each click of the mouse.  

You’ll find that, as you get comfortable with Revit, there are many, 

many choices and options behind each command. 

Let’s get started: 

First : To open Revit, click the icon on your desktop (see Figure 3.1). 

 

FIGURE  3 . 1  You can launch Revit from the desktop icon. 
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Second : After you start Revit, you’ll see the Recent Files window, as 

shown in Figure 3.2. The top row lists any projects on which you’ve 

been working; the bottom row lists any families with which you’ve been 

working. At the top of the dialog is the Learn pull down. This will give 

you access to the Autodesk Help website. 

 

FIGUR E 3 . 2 The Recent Files window lists any recent projects or 

families on which you’ve worked 

 

. To the left of the dialog is the Models area. Click the Open. . . 

link. 

 

Third : The New Project dialog shown in Figure 1.3 opens. Click 

the Tem- plate File drop-down menu, and select Architectural 

Template. If you’re a metric user, click the Browse button.  
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This will open Windows Explorer. Go up one level, and choose 

the S Metric folder. Select the file called default Metric. rte. If 

you cannot find this file. 

Now that the task of physically opening the application is out of 

the way, we can delve into Revit. Revit has a certain feel that 

Autodesk® AutoCAD® converts, or Micro Station converts, will 

need to grasp. At first, if you’re already a CAD user, you’ll notice 

many differences between Revit and CAD. Some of these 

differences may be off-putting, whereas others will make you 

say, ―I wish CAD did that.‖ Either way, you’ll have to adjust to a 

new workflow. 

 

FIGURE 3 . 3 The New Project dialog allows you to start a new project 

using a preexisting template file, or you can create a new template file. 

The Revit Workflow: 

This new workflow may be easy for some to adopt, whereas 

others will find it excruciatingly foreign.  

Executing a command in Revit is a three-step process: 

1. At the top of the Revit window is the Ribbon. A series of tabs is 
built into the Ribbon. Each tab contains a panel. This Ribbon will 
be your Revit launch pad! Speaking of launch pads, click the Wall 
button on the Architecture tab, as shown in Figure 3.4. 
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FIGURE  3 . 4  The Ribbon is the backbone of Revit. 

2. After you click the Wall button, notice that Revit adds a tab to 
the Ribbon with additional choices specific to the command you’re 
running, as shown in Figure 3.5. You may also notice that Revit 
places an additional Options bar below the Ribbon for even more 
choices. 

 
FI G URE 3 . 5  The Options bar allows you to have additional 

choices for the current command. 

3. After you make your choices from the Ribbon and the Options 

bar, you can place the object into the view window. This is the 

large drawing area that takes up two-thirds of the Revit interface. 

To place the wall, simply pick a point in the window and move your 

pointer in the direction that you want the wall to travel. The wall 

starts to form. Once you see that, you can press the Esc key to 

exit the command. (I just wanted to illustrate the behavior of Revit 

during a typical command). 

Using Revit isn’t always as easy as this, but just keep this basic 

three-step process in mind and you’ll be okay: 

1.Start a command. 

2.Choose an option from the temporary tab or the Options 

bar that appears. 

3.Place the item in the view window. 



 

76 | P a g e   

Student Notes (Computer Applications in Architecture) 

Dr. Huda Al baz 

   Thus, on the surface Revit appears to offer a fraction of the 

choices and functionality that are offered by AutoCAD (or any 

drafting program, for that matter).  

This is true in a way. Revit does offer fewer choices to start a 

command, but the choices that Revit does offer are much more 

robust and powerful. 

   Revit keeps its functionality focused on designing and 

constructing buildings. Revit gets its robust performance from the 

dynamic capabilities of the application during the placement of the 

items and the functionality of the objects after you place them in the 

model. You know what they say: never judge a chapter by its 

cover—unless, of course, it’s the chapter you’re reading right now. 

Let’s keep going with the main focus of the Revit interface: 

the Ribbon. You’ll be leaning on the Ribbon extensively in 

Revit. 

 

Using the Ribbon: 

You’ll use the Ribbon for the majority of the commands you 

execute in Revit. As you can see, you have little choice but to do 

so. However, this is good because it narrows your attention to 

what is right in front of you. 

When you click an icon on the Ribbon, Revit will react to that icon 

with a new tab, giving you the specific additional commands and 

options you need. Revit also keeps the existing tabs that can help 

you in the current command, as shown in Figure 3.6 Again, the 

focus is on keeping your eyes in one place. 

 

FIGURE 3 . 6   The Ribbon breakdown showing the panels 

In this chapter, I’ll throw quite a few new terms at you, but 

you’ll get familiar with them quickly. We just discussed the 
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Ribbon, but mostly you’ll be directed to choose a tab in the 

Ribbon and to find a panel on that tab. 

To keep the example familiar, when you select the Wall 

button, your instructions will read: ―On the Build panel of the 

Architecture tab, click the Wall button.‖ 

THAT Too Lbar Above THE Ribbon? 

This toolbar is called the Quick Access toolbar. I’m sure 

you’ve seen a similar toolbar in other applications. It comes 

filled with some popular commands. If you want to add 

commands to this toolbar, simply right-click any icon and 

select Add To Quick Access Toolbar. (see Figure 3.8). 

  
Figure 3.8 Quick Access Toolbar 

To the left of this toolbar is the Revit Application icon. 

Clicking this icon gives you access to more Revit functions 

that will be covered later in the chapter. One great icon that I 

like to have docked on the Quick Access toolbar is the Select 

Objects (or Modify) icon. I like to add this icon as shown in 

the following graphic: 

Now that you can see how the Ribbon and the tabs flow 

together, let’s look at another feature in the Ribbon panels 

that allows you to reach beyond the immediate Revit 

interface. 

The Properties Interface 

When you click the Wall button, a new set of commands 

appears on the Ribbon. This new set of commands 

combines the basic Modify commands with a tab specific to 

your immediate process. In this case, that process is adding 

a wall. 

You’ll also notice that the Properties dialog near the left of 

the screen changes, as shown in Figure 1.7. The Properties 

dialog shows a picture of the wall you’re about to place. If 

you click this picture, Revit displays all the walls that are 
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available in the model. This display is called the Type 

Selector drop-down (see Figure 3.8). 

FIGURE 3 . 8  Click the Properties button to display the Properties dialog. 

Typically, the dialog is shown by default. 

The objective of the next exercise is to start placing walls into 

the model: 

1. Close Revit by clicking the close button in the upper-right 

corner. 

2. Reopen Revit, and start a new project (Metric or Imperial). 

3. On the Architecture tab, click the Wall button. 

4. In the Properties dialog, select Exterior - Brick And CMU 

On MTL. Stud from the Type Selector. 

 (Metric users, select Basic Wall - Exterior Brick On MTL. 

Stud. This will look somewhat different throughout the 

chapter, but you get a break. It is slightly easier to work with 

than the Imperial wall type). 

 

Element Properties 

There are two different sets of properties in Revit: instance 

properties and type properties. Instance properties are available 

immediately in the Properties dialog when you place or select an 

item. If you make a change to an element property, the only items 

that are affected in the model are the items you’ve selected. 
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FIGURE 3 . 8 The Properties dialog gives you access to many 

variables associated with the item you’re adding to the model. 

 

The Properties Dialog 

As just mentioned, the Properties dialog displays the 

instance properties of the item you’ve selected. If no item is 

selected, this dialog displays the properties of the current 

view in which you happen to be. 

You also have the ability to combine the Properties dialog 

with the adjacent dialog, which is called the Project Browser 

(we’ll examine the Project Browser shortly). Simply click the 

top of the Properties dialog, as shown in Figure 1.9, and drag 

it onto the Project Browser. Once you do this, you’ll see a tab 

that con- tains the properties and a tab that contains the 

Project Browser (also shown in Figure 3.8). 

      Let’s take a closer look at the two categories of element 

properties in   Revit. 
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              Instance Properties. 

The items that you can edit immediately are called 

parameters or instance properties. These parameters 

change only the object being added to the model at this time. 

Also, if you select an item that has already been placed in 

the model, the parameters you see immediately in the 

Instance Properties dialog change only that item you’ve 

selected. This makes sense—not all items are built equally in 

the real world. Figure 3.9 illustrates the instance properties of 

a typical wall. 

  

 

FIGURE 3 . 9   Dragging the Properties dialog onto the Project Browser 

Type Properties: 

Type properties (see Figure 3.11), when edited, alter every 

item of that type in the entire model. To access the type 

properties, click the Edit Type button  
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in the Properties dialog, as Figure 1.12 shows. 

At this point, you have two choices. You can make a new 

wall type (leaving this specific wall unmodified) by clicking 

the Duplicate button at the upper right of the dialog, or you 

can start editing the wall’s type properties, as shown in 

Figure 3.10. 

Now that you’ve gained experience with the Type Properties 

dialog, it’s time to go back and study the Options bar as it 

pertains to placing a wall: 

 

1.Because you’re only exploring the element 
properties, click the Cancel button to return to the 
model. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 
FIGURE 3 . 1 0 The instance properties change only the currently  

placed item or the  currently selected item 
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FIGURE 3 . 1 1  The type properties, when modified, alter every occurrence of 

this specific wall in the entire model. 

 

 
FIGURE 3 . 1 2  The Edit Type button allows you to access the type 

properties. 
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FIGURE 3 . 1 3 The type properties modify the wall system’s 

global settings. 

 

 Click the Preview button at the bottom of the dialog to see 

the image that is displayed. 

2. Back in the Options bar, find the Location Line menu. 

Through this menu, you can set the wall justification. Select 

Finish Face: Exterior (see Figure 3.14).  

 
FIGURE 3 . 1 4 By selecting Finish Face: Exterior, you know the 

wall will be dimensioned from the outside finish. 
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3. On the Options bar, be sure the Chain check box is 

selected, as Figure 3.14 shows. This will allow you to draw 

the walls continuously. 

4. The Draw panel has a series of sketch options. Because 

this specific wall is straight, make sure the Line button is 

selected, as shown in Figure 3.15. 

FIGURE 3 . 1 5 You can draw any shape you need. 

 

Get used to studying the Ribbon and the Options bar—they 

will be your crutch as you start using Revit! Of course, at 

some point you need to begin placing items physically into 

the model. This is where the view window comes into play. 

The View Window 

To put it simply, the big white area where the objects go is 

the view window. As a result of your actions, this area will 

become populated with your model. 

Notice that the background is white—this is because the 

sheets you plot on are white. In Revit, what you see is what 

you get . . . literally. Line weights in Revit are driven by the 

object, not by the layer. In Revit, you aren’t counting on color 

#5, which is blue, for example, to be a specific line width 

when you plot. You can immediately see the thickness that 

all your lines will be before you plot (see Figure 3.16).  
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FIGURE 3 . 16  The view window collects the results of your 

actions. 

 

To continue placing some walls in the model, keep going with 

the exercise. (If you haven’t been following along, you can start by 

clicking the Wall button on the Architecture tab. In the Properties 

dialog box, select Exterior - Brick And CMU On MTL. Stud [or 

Basic Wall - Exterior Brick On Mtl. Stud for metric users]. Make 

sure the wall is justified to the finish face exterior.) You may now 

proceed: 

With the Wall command still running and the correct wall type 
selected, position your cursor in a location similar to the 
illustration in Figure 1.17. Pick a point in the view window. 

1. With the first point picked, move your cursor to the left. Notice 
that two things happen: the wall seems to snap in a horizontal 
plane, and a blue dashed line locks the horizontal position. In 
Revit, there is no Ortho. Revit aligns the typical compass 
increments to 0°, 90°, 180°, 270°, and 45°. 

2. Also notice the blue dimension extending from the first point to 
the last point. Although dimensions can’t be typed over, this type 
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of dimension is a temporary dimension for you to use as you 
place items. Type 100 (30000 mm), and press the Enter key. 
Notice that you didn’t need to type the foot mark ( ) or mm. Revit 
thinks in terms of feet or millimeters. The wall is now 100 (30000 
mm) long (see Figure 3.17). 
 

 
FIGURE 3 . 1 7  The procedure for drawing a wall in Revit 

 

4. With the Wall command still running, move your cursor straight 
up from the endpoint of your 100 -long wall. Look at Figure 3.18. 
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FIGURE 3 . 1 8  How Revit works is evident in this procedure. 

  

5. Type 80 (24000 mm), and press Enter. You now have two 

walls. 

6. Move your cursor to the right until you run into another blue 

alignment line. Notice that your temporary dimension says 100 –0 

(30000.0).  

Revit understands symmetry. After you see this alignment line, 

and the temporary dimension says 100 –0 (30000.0), pick this 

point. 

7. Move your cursor straight down, type 16 (4800 mm), and press 

Enter. 

8. Move your cursor to the right, type 16′ (4800 mm), and press 

Enter. 

9. Press the Esc key twice. 

Do your walls look like Figure 3.19 If not, try it again. You need to 

be comfort- able with this procedure (as much as possible). 
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FIGURE 3 . 1 9 Working with Revit starts with the ability to work with 

the view window and learn the quirks and feel of the interface. 

 

To get used to the Revit flow, always remember these three 

steps: 

1. Start a command. 

2. Focus on your options. 
3.Move to the view window, and add the elements to the 

model. 

If you start a command and then focus immediately on the 

view, you’ll be sitting there wondering what to do next. Don’t 

forget to check your Options bar and the appropriate Ribbon 

tab. 

Let’s keep going and close this building by using a few 

familiar commands. If you’ve never drafted on a computer 

before, don’t worry. These commands are simple. The 

easiest but most important topic is how to select an object. 
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Object Selection 

Revit has a few similarities to AutoCAD and Micro Station. 

One of those similarities is the ability to perform simple 

object selection and to execute common modify commands. 

For this example, you’ll mirror the two 16 –0 (4800 mm) L-

shaped walls to the bottom of the building: 

 

1.Type ZA (zoom all). 

2.Near the two 16 –0 (4800 mm) L-shaped walls, pick 

(left-click) and hold down the left mouse button when the 

cursor is at a point to the right of the walls but above the 

long, 100 –0 (30000 mm) horizontal wall. 

3. You see a window start to form. Run that selection 

window down and to the left past the two walls. After you 

highlight the walls, as shown in Figure 1.20, let go of the 

mouse button, and you’ve selected the walls. 

There are two ways to select an object: by using a crossing 

window or by using a box. Each approach plays an important 

role in how you select items in a model. 

 

Crossing Windows 

A crossing window is an object-selection method in which you 

select objects by placing a window that crosses through the 

objects. A crossing window always starts from the right and 

ends to the left. When you place a crossing window, it’s 

represented by a dashed-line composition (as you saw in Figure 

3.20). 
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FIGURE 3 . 2 0 Using a crossing window to select two walls 

Boxes 

With a box object-selection method, you select only items that are 

100 percent inside the window you place. This method is useful 

when you want to select specific items while passing through larger 

objects that you may not want in the selection set. A box always 

starts from the left and works to the right. The line type for a 

selection window is a continuous line (see Figure 3.21). 

Now that you have experience selecting items, you can execute 

some basic modify commands. Let’s begin with mirroring, one of 

the most popular modify commands. 

 

Modifying and Mirroring 

Revit allows you either to select the item first and then execute the 

command or to start the command and then select the objects to be 

modified. This is true for most action items and is certainly true for 

every command on the Modify toolbar. Try it: 

1. Make sure only the two 16 –0 (4800 mm) walls are selected. 

2. When the walls are selected, the Modify | Walls tab appears. 

On the Modify panel, click the Mirror – Draw Axis button, as 

shown in Figure 3.22. 
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FIGURE 3 .  2 1 To select only objects that are surrounded by the 

window, use a box. 

 

This will leave out any item that may be partially within the box. 

FIGURE 3 . 2 2  The Ribbon adds the appropriate commands. 

 

2.Your cursor changes to a crosshair with the mirror icon, 
illustrating that you’re ready to draw a mirror plane. 
3.Make sure the Copy check box is selected (see Figure 
3.23). 
 
 

 

 

 

 
FIGURE 3 . 2 3  There are options you must choose for every 

command in Revit. 
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4.Hover your cursor over the inside face of the 80 –0 (24000 
mm) vertical wall until you reach the midpoint. Revit displays a 
triangular icon, indicating that you’ve found the midpoint of the 
wall (see Figure 3.24). 

 

FIGURE 3 . 2 4  Revit has snaps similar to most CAD applications. 

 

 In Revit, you’ll get snaps only if you choose the Draw icon from 

the Options bar during a command. 

5.When the triangular midpoint snap appears, pick this point. 
After you pick the point where the triangle appears, you can 
move your cursor directly to the right of the wall. An alignment 
line appears, as shown in Figure 3.25. When it does, you can 
pick another point along the path. When you pick the second 
point, the walls are mirrored and joined with the south wall (see 
Figure 3.26). 
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FIGURE 3 . 2 5 Mirroring these walls involves (1) picking the midpoint 
of the vertical wall and (2) picking a horizontal point along the plane. 

 

 
 

FIGU RE 3 . 2 6  Your building should look like this illustration. 

Now that you have some experience mirroring items, it’s time 

to start adding components to your model by using the items 

that you placed earlier. If you’re having trouble following the 

process, retry these first few procedures. Rome wasn’t built 

in a day. (Well, perhaps if they’d had Revit, it would have 

speed things up!) You want your first few walls to look like 

Figure 1.26. 

Building on Existing Geometry 

You have some geometry with which to work, and you have 

some objects placed in your model. Now Revit starts to come 

alive. The benefits of using Building Information Modeling will 

become apparent quickly, as explained later in this chapter. 
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For example, because Revit knows that walls are walls, you 

can add identical geometry to the model by simply selecting 

an item and telling Revit to create a similar item. 

Suppose you want a radial wall of the same exact type as 

the other walls in the model. Perform the following steps: 

1.Type ZA to zoom the entire screen. 

2.Press the Esc key. 

3. Select one of the walls in the model—it doesn’t matter 

which one. 

4.Right-click the wall. 

5.Select Create Similar, as shown in Figure 3.27. 

 
FIGURE 3 . 2 7 You can select any item in Revit and create a 

similar object by right-clicking and selecting Create Similar. 

 

6. On the Modify | Place Wall tab, click the Start-End-Radius 

Arc button, as shown in Figure 3.28. 
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FIGURE 3 . 28 Just because you started the command from the 

view window doesn’t mean you can ignore your options. 

 

7. Again with the options? Yes. Make sure Location Line is 

set to Finish Face: Exterior (it should be so already). 

8.With the wheel button on your mouse, zoom into the upper 

corner of the building and select the top endpoint of the wall, 

as shown in Figure 3.29. The point you’re picking is the 

corner of the heavy lines. The topmost, thinner line 

represents a concrete belt course below. 

If you’re having trouble picking the correct point, don’t be 

afraid to zoom into the area by scrolling the mouse wheel. 

(Metric users do not have the concrete belt. Just pick the 

outside heavy line representing the brick face.) 

9. Select the opposite, outside corner of the bottom wall. 

Again, to be more accurate you’ll probably have to zoom into 

each point as you’re making your picks. 
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FIGURE 3 . 2 9  Select the top corner of the wall to start your new 

radial wall. 

10. Move your cursor to the right until you see the curved wall 
pause. You’ll see an alignment line and possibly a tangent snap 
icon appear as well. Revit understands that you may want an arc 
tangent on the two lines you’ve already placed in your model. 
11. When you see the tangent snap icon, choose the third point. 
Your walls should look like Figure 3.30. 

  

 

 

 

 

 

 

 

 

 

 

 
FIGURE 3 . 30 The completed exterior walls should look like this 

illustration. 
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Just because you’ve placed a wall in the model doesn’t 

mean the wall looks the way you would like it to appear. In 

Revit, you can do a lot with view control and how objects are 

displayed. 

View Control and Object Display 

Although the earlier procedures are a nice way to add walls 

to a drawing, they don’t reflect the detail you’ll need to 

produce construction documents. The great thing about 

Revit, though, is that you’ve already done everything you 

need to do. You can now tell Revit to display the graphics the 

way you want 

to see them. 

 

The View Control Bar 

At the bottom of the view window, you’ll see a skinny toolbar 

(as shown in Figure 3.31. This is the View Control bar. 

 

 
FIGURE 3 . 3 1   The View Control bar controls the graphical view 

of your model. 

 

It contains the functions outlined in the following list: 

Scale 

The first item on the View Control bar is the Scale function. It 

gets small mention here, but it’s a huge deal. In Revit, you 

change the scale of a view by selecting this menu. Change 

the scale here, and Revit will scale annotations and symbols 

accordingly (see Figure 3.32). 



 

98 | P a g e   

Student Notes (Computer Applications in Architecture) 

Dr. Huda Al baz 

 

FIGURE 3 . 3 2  The Scale menu allows you to change the scale of your view. 

Detail Level : Detail Level allows you to view your model at 

different qualities. You have three levels to choose from: 

Coarse, Medium, and Fine (see Figure 1.33). 

 

 
FIGURE 3 . 3 3 The Detail Level control allows you to set different 

view levels for the current view. 
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If you want more graphical information with this view, select 

Fine. To see how the view is adjusted using this control, 

follow these steps: 

1.Click the Detail Level icon, and choose Fine. 

2.Zoom in on a wall corner. Notice that the wall 

components are now showing in the view. 

There are other items on the View Control bar, but we’ll 

discuss them when they become applicable to the exercises. 

The View Tab 

Because Revit is one big happy model, you’ll quickly find that 

simply viewing the model is quite important. In Revit, you can 

take advantage of some functionality in the Navigation bar. 

To activate the Navigation bar, first go to the View tab and 

click the User Interface button. Then go to the default 3D 

view, and make sure the Navigation bar is activated, as 

shown in Figure 1.34. 

One item we need to look at on the Navigation bar is the 

steering wheel. 

The Steering Wheel 

The steering wheel allows you to zoom, rewind, and pan. 

When you click the steering wheel icon, a larger control 

panel appears in the view window. To choose one of the 

options, you simply pick (left-click) one of the options and 

hold down the mouse button as you execute the maneuver. 

To use the steering wheel, follow along: 

1. Go back to Floor Plan Level 1, and pick the steering wheel 

icon from the Navigation bar. 

2 . When the steering wheel is in the view window (as shown 

in Figure 3.35), left-click and hold Zoom. You can now zoom 

in and out. 
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FIGURE 3 . 3 4  The View tab allows you to turn on and off  

the Navigation bar. 

 

 

 

 

 

 

 

 

 

 

FIGURE 3 . 3 5  You can use the 

steering wheel to navigate through a view. 

 

3. Click and hold Rewind in the steering wheel. You can now 

find an older view, as shown in Figure 3.36. 
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FI G URE 3 . 36 Because Revit doesn’t include zoom commands in 

the Undo function, you can rewind to find previous views. 

 

4.Do the same for Pan, which is found on the outer ring of 

the steering wheel. After you click and hold Pan, you can 

navigate to other parts of the model. 

    Although you can do all this with your wheel button, some 

users still prefer the icon method of panning and zooming. 

For those of you who prefer the icons, you’ll want to use the 

icons for the traditional zooms as well. 

   When you’re finished using the steering wheel, press Shift 

+ W or right-click and choose Close Wheel. 

Traditional Zooms 

The next items on the Navigation bar are the good-old zoom 

controls. The abilities to zoom in, zoom out, and pan are all 

included in this function, as shown in Figure 3.37. 

FIGURE 3 . 37 The standard zoom commands 

    Of course, if you have a mouse with a wheel, you can 

zoom and pan by either holding down the wheel to pan or 

wheeling the button to scroll in and out. 

Thin Lines 
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Back on the View tab, you’ll see an icon called Thin Lines, as 

shown in Figure 3.38. Let’s talk about what this icon does. 

 
FIGURE 3 . 38 Clicking the Thin Lines icon lets you operate on the 

finer 

items in a model. 

     In Revit, there are no layers. Line weights are controlled by the 

actual objects they represent. In the view window, you see these line 

weights. As mentioned before, what you see is what you get. 

Sometimes, however, these line weights may be too thick for smaller-

scale views. By clicking the Thin Lines icon, as shown in Figure 3.38, 

you can force the view to display only the thinnest lines possible and 

still see the objects. 

To practice using the Thin Lines function, follow along: 

1.Pick the Thin Lines icon. 

2.Zoom in on the upper-right corner of the building. 

3. Pick the Thin Lines icon again. This toggles the mode back and 

forth. 

4. Notice that the lines are very heavy. 

The line weight should concern you. As mentioned earlier, there 

are no layers in Revit. This subject will be covered throughout this 

chapter. 

3D View 

The 3D View icon brings us to a new conversation. Complete the 

following steps, which will move us into the discussion of how a 

Revit model comes together: 
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FIGURE 3 . 3 9  The 3D View icon will be used heavily. 

1. Click the 3D View icon, as shown in Figure 3.39. 

2. On the View Control bar, click the Visual Style button and 

choose Realistic, as shown in Figure 3.40. 

3. Again on the View Control bar, select the Shadows On 

icon and turn on shadows, as shown in Figure 3.41. 

 

 

 

 

 

 

 

 

 
FIGURE 3 . 4 0 The Visual Style button enables you to view your 

model in color. This is typical for a 3D view. 

 

FIGURE 3 . 4 1  Shadows create a nice effect, but at the expense of 

RAM. 

 

Within the 3D view is the View Cube. It’s the cube in the 

upper-right corner of the view window. You can switch to 

different perspectives of the model by clicking the quadrants 

of the cube (see Figure 3.42). 
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FIGURE 3 . 4 2   The View Cube lets you look freely at different sides of 

the building. 

Your model should look similar to Figure 3.43. (Metric users, 

you do not have the concrete belt or the concrete block 

coursing below the brick.). 

Go back to the floor plan. Wait! How? This brings us to an 

important topic in Revit: the Project Browser. 

  

 
 

FIGURE 3 . 4 3 The model with shadows turned on 

 

3.2 The Project Browser 

Revit is the frontrunner of BIM. BIM has swept our industry 

for many reasons. 

One of the biggest reasons is that you have a fully integrated 

model in front of you. That is, when you need to open a 

different floor plan, elevation, detail, drawing sheet, or 3D 

view, you can find it all right there in the model. 



 

105 | P a g e   

Student Notes (Computer Applications in Architecture) 

Dr. Huda Al baz 

Also, this means your workflow will change drastically. When 

you think about all the external references and convoluted 

folder structures that make up a typical job, you can start to 

relate to the way Revit uses the Project Browser. In Revit, 

you use the Project Browser instead of the folder structure 

you used previously in CAD. 

This approach changes the playing field. The process of 

closing the file you’re in and opening the files in which you 

need to do work is restructured in Revit to enable you to stay 

in the model. You never have to leave one file to open 

another. You also never need to rely on external referencing 

to complete a set of drawings. Revit and the Project Browser 

put it all in front of you. 

To start using the Project Browser, follow along: 

1.  To the far left of the Revit interface are the combined 

Project Browser and Properties dialogs. At the bottom of the 

dialogs, you’ll see two tabs, as shown in Figure 1.44. Click 

the Project Browser tab. 
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FIGURE 1 . 4 4  The Project Browser is your new BIM Windows 

Explorer. 

 

2. The Project Browser is broken down into categories. The 

first category is Views. The first View category is Floor Plans. 

In the Floor Plans category, double-click Level 1. 

3. Double-click Level 2. Notice that the walls look different 

than in Level 1. Your display level is set to Coarse. This is 

because any change you make on the View Control bar is for 
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that view only. When you went to Level 2 for the first time, 

the change to the display level had not yet been made. 

4. In the view window, you see little icons that look like 

houses (see Figure 3.45). These are elevation markers. 

(Metric users, yours are round.) The elevation marker to the 

right might be in your building or overlapping one of the 

walls. If this is the case, you need to move it out of the way. 

 
FIGURE 3 . 4 5 Symbols for elevation markers in the plan. 

 

If you need to move them, you must do so by picking a 

window. There are two items in an elevation marker. 

 

5. Pick a box around the elevation marker. When both the 

small tri- angle and the small box are selected, move your 

mouse cursor over the selected objects. 

6. Your cursor turns into a move icon. Pick a point on the 

screen, and move the elevation marker out of the way. 

7. In the Project Browser, find the Elevations (Building 

Elevation)category. Double-click South. 

8. Also in the Project Browser, notice the 3D Views category. 

Expand the 3D Views category, and double-click the {3D} 

choice. This brings you back to the 3D view you were looking 

at before this exercise. 
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Now that you can navigate through the Project Browser, adding 

other components to the model will be much easier. Next, you’ll 

begin to add some windows.  

Windows 

By clicking all these views, you’re simply opening a view 

(window) of the building, not another file that is stored 

somewhere. For some users, this can be confusing.   ( It was 

initially for me.) 

When you click around and open views, they stay open. You can 

quickly open many views. There is a way to manage these views 

before they get out of hand. 

In the upper-right corner of the Revit dialog, you’ll see the 

traditional close and minimize/maximize buttons for the 

application. Just below them are the traditional buttons for the 

files that are open, as shown in Figure 3.46. Click the X to close 

the current view. 

FIGURE   3 . 4 6   You can close a view by clicking the X for the view. 

 This doesn’t close Revit—or an actual file for that matter—it simply 

closes that view. 

In this case, you have multiple views open. This situation (which is 

quite common) is best managed on the View tab. To use the Window 

menu, perform the following steps: 

1. On the Windows panel of the View tab, click the Switch 

Windows button, as shown in Figure 3.47. 
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FIGURE 1 .  4 7 The Switch Windows menu lists all the current 

views that are open. 

 

2. After the menu is expanded, look at the open views. 

3. Go to the {3D} view by selecting it from the Window menu 

and click- ing the 3D icon at the top of the screen or by going 

to the {3D} view in the Project Browser. 

4. On the Windows panel, click Close Inactive. 

5. In the Project Browser, open Level 1. 

6. Go to the Windows panel, and select Tile Views. 

7. With the windows tiled, you can see the Level 1 floor plan 

along with the 3D view to the side. Select one of the walls in 

the Level 1 floor plan. Notice that it’s now selected in the 3D 

view. The views you have open are mere representations of 

the model from that perspective. 

Each view of the model can have its own independent view 

settings. 

8. Click into each view, and type ZA. Doing so zooms the 

extents of each window. This is a useful habit to get into. 

You’re at a safe point now to save the file. This also brings us to 

a logical place at which to discuss the various file types and their 

associations with the BIM model. 

 

3.3 File Types and Families 

Revit has a unique way of saving files and using different file 

types to build a BIM model. To learn how and why Revit has 

chosen these methods, follow along with these steps: 

1.Click the Save icon (see Figure 3.48). 
2. In the Save As dialog, click the Options button in the lower-
right corner (see Figure 3.49). 
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FIGURE 3 . 48 The traditional Save icon brings up the Save As 

dialog if the file has never been saved. 

 

 

 

 

 

 
FIGURE 3 . 4 9 The Options button in the Save As dialog lets you 

choose how the file is saved. 

 

3. In the File Save Options dialog is a place at the top where you 

can specify the number of backups, as shown in Figure 3.50. Set 

this value . 

FIGURE 3 . 50 The options in the File Save Options dialog box let you specify  

the number of backups and the view for the preview. 
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4. Revit provides this option because when you click the Save 

icon, Revit duplicates the file. It adds a suffix of 000 to the end 

of the file- name. Each time you click the Save icon, Revit 

records this save and adds another file called 000 , leaving 

the 000 file intact. The default is to do this three times before 

Revit starts replacing 000002, and 0003 with the three most 

current files. 

5. In the Preview section, you can specify in which view this 

file will be previewed. I like to keep it as the active view. That 

way I can get an idea of whether the file is up to date based 

on the state of the view. Click OK. 

6.Create a folder somewhere, and save this file into the 

folder. The name of the file used as an example in the chapter 

is ER.rvt. (NER stands for ―No Experience Required.‖) Of 

course, you can name the file anything you wish, or you can 

even make your own project using the steps and examples 

from the chapter as guidelines. 

    Now that you have experience adding components to the 

model, it’s time to investigate exactly what you’re adding here. 

Each component is a member of what Revit calls a family . 

System and Hosted Families (.rfa) 

A Revit model is based on a compilation of items called families. 

There are two types of families: system families and hosted 

families. A system family can be found only in a Revit model and 

can’t be stored in a separate location. A hosted family is 

inserted similarly to a block (or cell) and is stored in an external 

directory. The file extension for a hosted family is rf 

System Families 

System families are inherent to the current model and aren’t 

inserted in the traditional sense. You can modify a system 

family only through its element properties in the model. The 

walls you’ve put in up to this point are system families, for 

example. You didn’t have to insert a separate file in order to 

find the wall type. The system families in a Revit model are 

as follows: 
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 Walls 
 Floors 
 Roofs  
 Ceilings  
 Stairs 
 Ramps 
 Shafts Rooms 
 Schedules/quantity takeoffs 
 Text 
 Dimensions  
 Views 

 
 System families define your model. As you can see, the list 

pretty much covers most building elements. There are, 

however, many more components not 

included in this list. These items, which can be loaded into 

your model, are called hosted families. 

Hosted Families 

All other families in Revit are hosted in some way by a 

system family, a level, or a reference plane. For example, a 

wall sconce is a hosted family in that, when you insert it, it’s 

appended to a wall. Hosted families carry a file extension of 

.rf . To insert a hosted family into a model, follow these 

steps: 

1.Open the NER- 1 rv file or your own file. 

2. Go to Level 1. 

3. On the Architecture tab, click the Door button. 

4.On the Modify | Place Door tab, click the Load Family 

button, as shown in Figure 3.51. This opens the Load Family 

dialog. 
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FIGURE 3 . 5 1  You can load an RFA file during the placement 

of a hosted family. 

5. Browse to the D r directory. 

   Note that, if you’re on a network, your directories may not 

be the same as in this chapter. Contact your CAD/BIM 

manager (or whoever loaded Revit onto your computer) to 

find out exactly where they may have mapped Revit. 

6. Notice that there is a list of doors. Open the ommercial 

folder, select Door-Exterior-Double_Two-Lite.rfa, and click 

Open. (Metric users, select M Double-Panel 2.rfa.) 

7. In the Properties dialog, click the Type Selector, as 

shown in Figure 1.52. Notice that in addition to bringing in 

the door family, you have seven different types of the door. 

These types are simply variations of the same door. You no 

longer have to explode a block and modify it to fit in your 

wall. 

 

 

 

 
 

 

 



 

114 | P a g e   

Student Notes (Computer Applications in Architecture) 

Dr. Huda Al baz 

 

FIGURE 3 . 5 2 Each family RFA file contains multiple types 

associated with that family. 

 

8. Select Door-Exterior-Double-Two_Lite 72 × 80 as shown 

in Figure 1.52. 

9. Zoom in on the upper-left corner of the building, as shown 

in Figure 1.53. 

10. To insert the door into the model, you must place it in the 

wall. (Notice that before you hover your cursor over the 

actual wall, Revit won’t allow you to add the door to the 

model, as shown in Figure 3.53.) When your pointer is 

directly on top of the wall, you see the outline of the door. 

Pick a point in the wall, and the door is inserted. (We’ll cover 

this in depth in the next chapter.). 

 

 

 

 

 

 

  

 



 

115 | P a g e   

Student Notes (Computer Applications in Architecture) 

Dr. Huda Al baz 

 

 

 

 

 

 

 

 

 

 

 

 

 
FIGURE 3 . 5 3 Inserting a hosted family ( rf ) 

11. Delete the door you just placed by selecting it and 

pressing the Delete key on your keyboard. This is just 

practice for the next chapter. 

You’ll use this method of inserting a hosted family into a model 

quite a bit in this chapter and on a daily basis when you use 

Revit. Note that when a family is loaded into Revit , there is no 

live path back to the file that was loaded. After it’s added to the 

Revit model, it becomes part of that model. To view a list of the 

families in the Revit model, go to the Project Browser and look for 

the Families category. There you’ll see a list of the families and 

their types, as Figure 1.54 shows. 

The two main Revit file types have been addressed. Two others 

are also crucial to the development of a Revit model. 

 

Using Revit Template Files (.rte) 

The r extension pertains to a Revit template file. Your company 

surely has developed a template for its own standards or will do 

so soon. An .r e file is the default template that has all of your 

company’s standards built into it. When you start a project, you’ll 

use this file. To see how an r e file is used, follow these steps: 

 



 

116 | P a g e   

Student Notes (Computer Applications in Architecture) 

Dr. Huda Al baz 

1. Click the File Tab, and select New Project. 

2. In the resulting dialog, shown in Figure 3.55, click the 

Browse button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
FIGURE 3 . 5 4  All the families are listed in the Project Browser. 

 

3. Browsing throws you into a category with several other 

templates. You can now choose a different template. 
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FIGURE 3 . 5 5  A new Revit model is based on an RTE template file. 
 

4.Click Cancel twice. 

Whenever you start a project, you’ll use the RTE template. 

When you start a new family, however, you’ll want to use an 

RFT file. 

 

Using Revit Family Files (.rft) 

The rf extension is another type of template—only this one 

pertains to a family. It would be nice if Revit had every family 

fully developed to suit your needs. Alas, it doesn’t. You’ll 

have to develop your own families, starting with a family 

template. To see how to access a family template, perform 

these steps: 

1.Click the File tab, and select NewFamily to open the 

browse dialog shown in Figure 1.56. 
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FIGURE 4 . 5 6   The creation of a family starts with templates. 

 

1. Browse through these templates. You’ll most certainly use 
many of them. 

2. Click the Cancel button. 
 

3.4  Creating a Project  

When creating a project in Revit Architecture, you can : 

■ Use default settings, which are defined in a project template. 
Revit Architecture includes a default template called : 
Default .rte, which contains several settings to help you begin 
the design process immediately. For information about 
changing the default template, see File Location Options . 

■ Use a custom template. 

Creating a Project Using Default Settings 

Use this procedure when you want to use the default 
template. It skips the step of specifying the template to use 
when creating the project. 

Do one of the following: 

■ Press Ctrl +N. 

■ On the Recent Files  window, under Projects, click New. 
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Revit Architecture creates a project file, using settings in 
the default template. The default project name displays in 
the title bar of the Revit window. To assign a different file 

name, click   ➤ (Save As). 

Creating a Project Using a Template 

Use this procedure when you want to be able to specify the 
template to use when creating the project. 

1 .Click    ➤ New ➤  (Project). 

2 .In the New Project dialog, for Template file, click Browse. 

3 .Navigate to the location of the desired project 
template, select the template file (with the file type RTE), 
and click Open. 
 

Revit Architecture provides several project templates, which 
reside in the Metric Templates or Imperial Templates folder in 
the following location: 

■ Windows XP: 
 C:\Documents and Settings\All Users\Application 

Data\Autodesk\<product name and release>\ 

■ Windows Vista or Windows 7: 
C:\ProgramData\Autodesk\<product name and release>\ 

You can use one of these templates or create your own 
templates as needed to maintain corporate standards or to 
simplify the setup process for different types of projects. 

4 .For Create new, click Project. 

5 .Click OK. 
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Revit Architecture creates a project file using the settings 
defined by the specified template. The default project name 
appears in the title bar of the Revit window. To assign a 

different file name, click   

 ➤  (Save As). 

        Related topics 

■ Creating a Template  

■ Project Template Settings . 
 
 

Before You Begin a Project 

Before you start adding content to a Revit project, consider the 
following approaches to the design process: 

■  
Using levels and grids. Begin the design process by 
defining levels and grids for the model. See Levels and 
Grids . 

■ Importing data. If you started the design process using 
another CAD program (such as AutoCAD), you can import 
existing data. Revit Architecture imports  various  CAD  formats,  
including  DWG,  DXF,  DGN, and ACIS SAT files, as well as 
Sketch Up (SKP) files and Industry Foundation Classes (IFC). 
See Import/Link Overview . 

■ Massing. You can start a project by designing a conceptual 
model. After you create basic shapes with the massing tools, 
you can convert mass faces to building elements. See 
Massing Studies  and Conceptual Design Environment . 
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3.5 Using Information from Other Sources 

Read these topics to learn how to incorporate information from 
other sources into Revit projects. 

Import/Link Overview 

 . The Import and Link tools allows you to import or link to 
various file formats. 

 . Different file formats may be imported with different 
qualities of geometry. For information about variations in 
imported geometry, see Suitability of Imported 
Geometry . 

 . When you import files, you may need to zoom in the 
drawing area to see the imported data. See Zooming 
Project Views . 

 . For information about linking Revit models, see Linked 
Models . 

Suitability of Imported Geometry 

When you import a file into Revit Architecture, the format of 
the imported file may support varying qualities of geometry. 
These variations are caused by the file type, the export 
settings, and the import settings. 

Some tools and capabilities in Revit Architecture require 
specific types of geometry. For example: 

■ . The Join Geometry tool requires volumetric geometry. 

■ Rendering an image requires that faces are associated with 
material properties. 

■ The Roof by Face tool requires geometry with 
suitably sized faces for flat roof panels or a NURB 
representation of a complex, shaped roof panel. 

■ Masses require volumetric geometry to calculate 
volume, surface area, and floor area faces. See 
Considerations for Imported Geometry in Mass or Generic 
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Model Families and Importing Massing Studies from Other 
Applications . 
 
You can import many different types of file formats into 
Revit Architecture. When you export a file from the 
originating application for use with Revit Architecture, 
you can set a variety of export options. With these many 
variations of file formats and export options, it is 
important to ensure that the exported file. 

provides the geometric data needed for the Revit 

capability that you plan to use. To optimize results with 

various file formats, consult the documentation provided 

with the exporting applications. 

Implications of Importing vs. Linking for Xrefs 

Suppose you use AutoCAD to generate a DWG file that 

contains external references (xrefs). When you import or 

link the DWG file, Revit Architecture displays the 

geometry from the nested xrefs. The decision to import or 

link a file to a Revit project affects what you can do with 

the xref information: 

■ If you import the file, you can explode the nested xrefs 
to Revit elements. However, if the xref file is updated 
after the import, Revit Architecture will not 
automatically reflect changes to the xref file. 

■ If you link the file, Revit Architecture automatically 
updates the geometry to reflect changes to the xref 
files. However, you cannot explode the nested xrefs 
to Revit elements. 

For more information, see Exploding Imported Geometry . 

Importing or Linking CAD Formats 

Open a Revit project, and use the Import CAD or Link 

CAD tools to import or link vector data from other CAD 

programs such as AutoCAD (DWG and DXF), Micro 
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Station® (DGN), Sketch Up (SKP and DWG), and 

ACIS (SAT). Revit Architecture supports importing most 

DGN surfaces and solids with the exceptions of cones, 

B-Spline surfaces, and Smart Solids. 

In addition to using the Import CAD and Link CAD 

tools, you can import CAD files using drag-and-drop 

from Windows®  Explorer onto a model, drafting, or sheet 

view of Revit Architecture. See Importing CAD Files 

Using i-drop . 

        You can mirror imported and linked CAD files. See Mirroring 

Elements. 

 

NOTE Revit Architecture :  

imports ACIS solids from SAT files. SAT file formats later than 

version 7.0 do not import into Revit Architecture. You should 

determine which version your solid modeling program is creating. 

Some solid modeling products (such as form-Z®) create SAT file 

formats later than version 7.0 by default. 

 

Snapping to Imported Geometry 

Suppose that you import an AutoCAD® drawing into 

Revit Architecture and then want to trace over walls in 

that drawing. As you place the cursor near the lines 

representing the walls, it can snap to the lines or the 

midpoint between the lines. 
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Proxy Graphics from AutoCAD Files 

Revit Architecture supports reading in proxy graphics 
from AutoCAD files. Proxy graphics are AutoCAD's 
representations of AutoCAD Architecture objects. 
Unlike AutoCAD Architecture objects, proxy graphics 
have no intelligence. 

Proxy graphics can exist for many types of data in 
AutoCAD, including Mechanical Desktop (MDT) 
parts and AutoCAD Runtime extension (ARX) 
objects. If you set the Proxy graphics command to 
1 in AutoCAD, Revit Architecture can then import 
ARX objects and AutoCAD Architecture objects (such 
as walls and floors) in the DWG or DXF file. 

 
Subdivision Surfaces and Solids Created in AutoCAD 

Revit Architecture can import DWG files containing 
subdivision surfaces and  solids  created  in  AutoCAD. 
Some complex subdivision meshes may fail to convert 
to a traditional solid or surface altogether, or generate a 
problematic solid or surface. Other highly complex 
SubD meshes may not import completely or at all. 
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Cutting Imported Geometry 

When you import a 3D DWG file into a Revit 
Architecture project, the imported DWG geometry will 
not be cut. For example, if you create a level at the 
elevation of a typical wall and then go to that plan view, 
the imported geometry will not cut at that level. 
However, if you import the geometry into a cut table in-
place family (such as Generic Model), the geometry will 
cut in accordance with Revit Architecture’s cut planes. 

Importing or Linking CAD Files Using the Import CAD and Link 
CAD Tools 

1 Click Insert tab ➤ Import panel ➤  (Import CAD), or 

click Insert tab ➤ Link panel ➤ 

 (Link CAD). 

If you link the file instead of importing it, see 
Implications of Importing vs. Linking for Xrefs. 

2 In the Import CAD Formats or Link CAD Formats 
dialog, navigate to the folder that contains the file to 
import or link. 

3 Select the file. 

4 Specify the import or link options. See Import and 
Link Options for CAD Formats and Revit Models . 

5 Click Open. 

6 If you chose to manually place the imported data, it 
displays in the drawing area and moves with the 
cursor. Click to place the imported data. 

You may need to zoom in to see the imported data. See 
Zooming Project Views . 
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Related topics 

■ Importing or Linking CAD Formats . 

■ Moving a View-Specific Import to the Foreground or 
Background . 

Importing CAD Files Using i-drop 

Revit Architecture supports the Autodesk i-drop® 

drag-and-drop feature. When i-drop objects are 
pulled from an i-drop–enabled web page, Revit 
Architecture downloads the file and imports it as if it 
were pulled from a local file. 

When you drag-and-drop a file, the file is imported 
with the default settings. If you want to use different 
settings (for example, Manual - Origin rather than 
Auto - Center to Center), import the file using the 
Import CAD tool. (See Importing or Linking CAD 
Files Using the Import CAD and Link CAD Tools.   

 
To import CAD files using i-drop 

1 . From an i-drop–enabled web page, click the 
thumbnail image of the object. 

2 . Drag the file from the web page into Revit 
Architecture. 

3 . Release the object directly into the active view.
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Importing Files from Sketch Up 

Google™ Sketch Up® is a general purpose 
modeling and visualization tool. Revit Architecture 
uses building information modeling (BIM), in which 
building elements understand their relationship to 
each other. When working on a design project, you 
can use both products to leverage the unique 
strengths of each. For example: 

■ If you want to model an initial design pass or 
quickly model a single element, start with Sketch 
nUp. Later, use Revit Architecture to refine the 
design. 

■ If you want to design entire building masses 
and then associate real building elements to 
them, use Sketch Up for the design phase. 
Later use Revit Architecture for the detailed 
planning phase. 

 
To use a Sketch Up design in Revit Architecture, 
import a SKP file from SketchUp directly into Revit 
Architecture. As an alternative, you can use Sketch 
Up to export a DWG file, and then import that DWG 
file into Revit Architecture. 

To incorporate a SketchUp design into a Revit project, 
use the following general process: 

1 Use Revit Architecture to create a family outside the 
project or an in-place family within the project. 

2 Import the SketchUp file into the family. 

3 If you created the family outside the project, load 
the family into the project. 

Related topic 

■ Importing Massing Studies from Other Applications . 
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Importing SKP Files 

Before importing a SKP file from SketchUp into Revit 
Architecture, do the following: 

■ Make sure you import the geometric data 
needed for the Revit capability that you plan to 
use. See Suitability of Imported Geometry . 

■ Review Limitations of SketchUp Data Imported to 
Revit Architecture. 

■ Review Best Practices When Importing Masses . 
 

To import Sketch Up files 

1 Create an in-place family in a Revit project, or 
create a family in the Family Editor. 

See Revit Families . 

2 Click Insert tab ➤ Import panel ➤  (Import 

CAD). 

3 In the Import CAD Formats dialog, navigate to the 
folder that contains the Sketch Up file. 

4  For Files of Type, select the SKP file type 

5  Select the file to import. 

6  Specify the desired import settings. 

The following settings are recommended: 

■ Colors: Preserve 

■ Layers: All 

■ Import Units: Auto-Detect 

■ Positioning: Auto - Origin to Origin 

■ Place at: Level 1 or Ref. Level 

■ Orient to View 

7 Click Open. 
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You may need to do the following to see the Sketch Up-
based form: 

■ Switch to a 3D view. 

■ To improve visibility, on the View Control Bar, for 
Visual Style, select  (Shaded with Edges). 

■ Click Home tab ➤ Work Plane panel ➤  (Set). In 

the Work Plane dialog, select a plane. 

■ Type ZF (Zoom to Fit) to adjust the drawing area to 
show the entire mass. 

■ If you are creating a mass family, click Massing 

& Site tab ➤ Conceptual Mass panel ➤  

(Show Mass). 
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Limitations of Sketch Up Data Imported to Revit Architecture 

Revit Architecture treats the data imported from 
Sketch Up as a large block of geometry that resists 
being manipulated (in the ways that you can usually 
manipulate geometry that is native to Revit 
Architecture). However, you can change the layer 
settings from Sketch Up. (For example, to assign 
colors or materials on a by-layer basis, click Manage 

tab ➤ Settings panel ➤ Object Styles, and change 

settings on the Imported Objects tab.) When you 
import a Sketch Up design into a Revit mass family 
and then load the mass family into a Revit project, 
you can convert mass faces (from the Sketch Up 
design) into walls, floors, and roofs. (See Importing 
Massing Studies from Other Applications .) 

When creating content in Sketch Up for use in Revit 
Architecture, consider the following restrictions: 

■ Exploding 3D data: In Revit Architecture, you 
will not be able to explode 3D data. If you try 
this, 3D faces will disappear, and you will 
receive a warning message. 

■ Parameters: In Revit Architecture, you cannot 
add parameters to control geometric flexing. 
However, you can add some controls that 
manipulate imported data, such as the location of 
an imported element and its material 
assignments. 

■ Visibility/graphics: In Revit Architecture, you 
cannot manipulate the geometry or isolate parts 
of whole elements with visibility/graphics settings. 

■ Two-sided surfaces: If a material or color is 
assigned to only one side of a surface in Sketch 
Up, Revit Architecture applies the material or 
color to both sides of the surface by default. If 
there is material on both sides of the surface, 
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Revit Architecture applies the Face 1 material to 
both sides. If faces are flipped and painted 
differently in Sketch Up, they may not display the 
correct material in Revit Architecture. 

■ Sketch Up properties: The following Sketch Up 
properties are currently not supported in Revit 
Architecture import: Texture Image Maps, 
Transparency, ―Smooth‖ Curved Surfaces, Text 
and Dimensions, Raster Images, and saved 
―Pages‖. 

■ Cut planes: Imports cannot be cut by a cut 
plane unless imported into a cut table family 
category. See Cut table Families . 

■ Sketch Up and massing: Not all Sketch Up 
imports are appropriate to massing. See 
Suitability of Imported Geometry . 

 Also see Importing Massing Studies from Other 
Applications . 

■ Scaling: Groups or components that have been 
scaled in their entirety with the SketchUp Scaling 
tool may be incorrectly scaled when imported to 
Revit Architecture. Exploded SketchUp models 
should import at the correct scale. 

       Importing ACIS Objects 

Revit Architecture supports the import of ACIS 
objects contained in DWG, DXF, and SAT files. 
(ACIS objects describe solids or trimmed surfaces.) 
For example, you can create ACIS objects using the 
AutoCAD commands Draw Solids and Draw Region. 

You can also import Smart Solids™ from Micro 

Station® into Revit Architecture. To import ACIS 
objects, use the procedure Importing or Linking 
CAD Files Using the Import CAD and Link CAD 
Tools . 
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Revit Architecture supports the following types of 
surfaces when importing ACIS objects: 

■ Plane 

■ Sphere 

■ Torus 

■ Cylinder 

■ Cone 

■ Elliptical cylinder 

■ Elliptical cone 

■ Extruded surface 

■ Revolved surface 

■ NURB surfaces 
 

You can import NURB (non-uniform rational B-
splines) surfaces on ACIS objects in DWG or SAT 
files into Revit mass or generic model families while 
you are creating the family. You can then use the 
Roof by Face and Curtain System by Face tools to 
create roofs and curtain systems on these imported 
surfaces. For more information, see Modeling by 
Face . 

To use ACIS imports for face-based host tools, import 
geometry into an in-place family of category Mass or 
Generic Model. Face-based tools work best on ACIS 
solids. For example, if you create walls by face on a cube, 
the walls join and miter correctly. If you create a curtain 
system by face on a solid, you can add corner mullions 
onto the joins between faces of the curtain system. For 
more information on face-based tools, see Creating 
Building Elements from Mass Instances . 
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Import and Link Options for CAD Formats and Revit Models 

The following options apply to linked or imported CAD 
format files (on the Import CAD Formats and Link CAD 

Formats dialogs that display when you click Insert tab ➤ 

Import panel ➤ Import CAD, or Insert 

 

tab ➤ Link panel ➤ Link CAD). Positioning options also 

apply to linked Revit models (when you click Insert 

tab ➤ Link panel ➤ Link Revit). 

 

The following is options and definitions :
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Option 

Current 

View 

Only 

Definition 

Imports a CAD drawing into the active Revit view 

only. For example, you might want an AutoCAD 

object to appear only in a Revit floor plan view 

and not in a 3D view. If you set this option, any 

text in the imported file is visible and can be 

cropped by the crop region of the view. If you are 

using work sharing, the import will belong to a 

view work set. 

If the option is not selected, only lines and 

geometry are imported, and the import be- haves 

like model geometry: it can be cropped by the crop 

region of the view. This option is not available in 

3D views. If you are using work sharing, the 

import will belong to a model work set. 

Colors 

Invert Inverts the colors of all line and text objects from the 

imported file to Revit-specific colors. Dark colors 

become lighter, and light colors become darker. This 

can improve readability when the file is in Revit 

Architecture. This option is set by default. 

Preserve        Preserves the colors defined in the imported. 

 
Black and 

White 

 

Imports the document in black and white. 
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Option            Definition 
 

  Layers

All Imports or links all layers. Layers that are not 

visible in the link are turned off in the current 

view in Revit Architecture. 

 

Visible     Imports or links only visible layers. 

 Specify  Allows you to select the layers and levels to import 

or link (on the dialog that displays). Layers not 

selected are deleted. 

If you select Visible or Specify and you are linking 

the file, when you later reload the linked file, still 

only the selected or visible layers originally linked 

are loaded. Any layers not selected or visible are 

not linked. If you later want omitted layers to be 

linked, you must delete the link and relink the file. 

 

TIP If you want to be able to see and hide layers as 

needed, you can link to all layers, and then click View 

tab ➤ Graphics panel ➤ Visibility/Graphics to control 

the visibility of different categories in a view. (See 

Visibility and Graphic Display in Project Views .) Or you 

can link to all layers, and then query the import and hide 

a selected layer in the active view. (See Querying 

Objects in Layers .
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Option 

Import 

Units 

 
 

 
 
 

 

 

 

Definition 
Explicitly sets the unit of measure for imported 

geometry. The values are Auto-Detect, feet, inch, 

meter, decimeter, centimeter, millimeter, and 

Custom factor. 

If you specify Auto-Detect for an AutoCAD file 

created in Imperial (English), then the file imports 

with feet and inches as the units. If the AutoCAD 

file was created in metric, then the file imports into 

Revit Architecture with millimeters as the units. 

For Micro Station® files, Revit Architecture reads 

the units from the file and uses them. 

Feet, inches, meters, centimeters, decimeters, 

millimeters are all supported. If the DGN file has 

custom units, then the unit in Revit Architecture 

defaults to feet. 

 

For example, the file has a unit called widget where one 

widget equals 10 meters. When importing the file, select 

Custom factor for Import Units and specify a value of 10 

in the adjacent text box. Each unit from the source file 

is now equal to 10 meters in the Revit file. 

The value you enter here displays in the Scale Factor 

type property of the import symbol. If the units are 

known, you can select Custom factor and enter a scale 

factor. This can increase or decrease the size of the 

imported elements in Revit Architecture.. 
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Option               Definition 

Positioning

Auto 

Center to 

Center 

 
 
 
 
 
 

 
Auto 

Origin to 

Origin 

Revit Architecture places the center of the import at 

the center of the Revit model. The center of a Revit 

model is calculated by finding the center of a 

bounding box around the model. 

If most of the Revit Architecture model is not visible, 

this center point may not be visible in the current view. 

To make the point visible in the current view, set the 

zoom to Zoom View to Fit. This centers the view on 

the Revit Architecture model. 

Revit Architecture places the import’s world origin at 

the Revit project’s internal origin. If the import object 

has been drawn at a large distance from its origin, 

it may display at a large distance from the model. 

To test this, set the zoom to Zoom View to Fit. 

Auto - By 

Shared 

Coordinates 

 
 
 
 

 
Manual  

Origin 

Revit Architecture places the imported geometry 

according to its position with respect to the shared 

coordinates between the 2 files. 

If there is no current shared coordinate system 

between the files, Revit Architecture notifies you, and 

uses Auto - Center to Center positioning. See 

Shared Positioning . 

The imported document's origin is centered on the 

cursor. 

Manual  

Base 

Point 

    The imported document's base point is centered on 

the cursor. Use this option only for AutoCAD files that 

have a defined base point. 
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Option 

Manual  

Center 

 

Definition 

    Sets the cursor at the center of the imported 

geometry. You can drag the imported geometry 

to its position. 

 

Place at            Select the level to place the origin/base point. 

 
Orient to 

View 

Revit Architecture places the import at the same 

orientation as the current view. This option is 

available only for non–view-specific imports. 

 

 

Setting Scaling for Imported DWG or DXF Files 

- Select an import symbol and click Modify | <File 

Name> tab ➤ Properties panel ➤   (Type 

Properties). 

- In the Type Properties dialog, modify Import 
Units or Scale Factor. 

- If you change the import units, the scale factor 
automatically updates. See Import and Link 
Options for CAD Formats and Revit Models . 

- Click OK. 
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Setting Line Weights for Imported DWG or DXF Files 

When you import a DWG or DXF file, each layer in 
the file is assigned a line weight based on the pen 
number-line weight settings. Revit Architecture can 
import pen numbers from a DWG or DXF file and 
map them to a Revit line weight. You can then save 
these mappings in a text file, and they become the 
set mappings for the project. 

Revit Architecture includes the following files with pen 
and line weight mappings: 

■ importlineweights-dwg-AIA.txt 

■ importlineweights-dwg-BS1192.txt 

■ importlineweights-dwg-ISO13657.txt 

■ importlineweights-dwg-CP83.txt 
 

These files reside in the Data folder of the Revit 
Architecture installation directory. 

 
To set line weights 

1  Click Insert tab ➤ Import panel ➤  . 

The Import Line Weights dialog displays the 
mappings in the importlineweights-dwg-default.txt 
file. 

2 If this is not the file that you want to edit, click 
Load, navigate to the correct mappings file, 
and open it. 

3 In the dialog, match the appropriate pen to the 
appropriate line weight (for  example:  Pen 
Number 1 to Line Weight Number 1, Pen 
Number 2 to Line Weight Number 2, and so 
on). Set as many pen-line weight Mapping as 
desired . 
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AutoCAD SHX Fonts to TrueType Fonts 

When you import AutoCAD drawings that contain text, 
you can map the AutoCAD SHX fonts to TrueType fonts 
so they appear correctly in Revit Architecture. You can 
map to any of your existing fonts. 

To map TrueType fonts 

1 Open the shxfontmap.txt file in a text editor. 

This file resides in the Data folder of the Revit 
Architecture installation directory. 

2 On a new line, enter the SHX file name. 

3 Press Tab. 

4 Enter the name of the font to map it to. 

5 Save and close the file. 

You do not need to restart Revit Architecture for the font 
mapping to take effect. If you have already imported the 
file, you will need to import it again. 

 

Setting Constraint Parameters for Imported Geometry 

If you have imported geometry into all views, you 
can set the base level for it and specify a height 
offset from that level. 

 
To set constraint parameters 

1  Select the imported geometry. 

2  On the Properties palette, set the Base Level and 
Base Offset instance parameters. 

Alternatively, you can select the geometry in an 
elevation view and move it to adjust the base offset 
value. 
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Moving a View-Specific Import to the Foreground or Background 

You can move a view-specific import symbol between the 
foreground and the background of a view, with respect to 
model elements in the view. If the import symbol is in the 
foreground of the view, it is in front of model elements, such 
as walls. It is still behind detail components and annotations. 

1 Select the import symbol. 

2 On the Properties palette, for Draw Layer, specify 
Background or Foreground. 

 

Alternatively, select Background or Foreground from the 
Options Bar. 

You can also use the sort order for detail components to 
move an import symbol in front of or behind detail 
components. For more information on sort order tools, 
see Sorting the Draw Order of Detail Components. 

 

Importing Images 

You can import raster images to a Revit project to use 
as background images or as visual aids needed 
during the creation of a model. By default, images 
are imported behind the model and annotation 
symbols; however, you can change the display 
order. You can import images into 2D views only. 

You can import images using the Image tool or by 

dragging and dropping them from Windows® Explorer. 
 
To import an image 

1 Click Insert tab ➤ Import panel ➤  (Image). 

2 In the Import Image dialog, navigate to the 
folder containing the image file to import. 

3 Select the file, and click Open. 
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The imported image displays in the drawing area 
and moves with the cursor. The image displays 
symbolically, with 2 crossing lines indicating 
the extents of the image. 

4 Click to place the image. 
 

Related topic 

■ Adding an Image to a Sheet . 
 

Modifying Imported Images 

You can modify imported images using tools (such as 
Rotate and Copy) on the Modify Raster Images tab. This 
tab displays when you select an imported image in the 
drawing area. 

To modify an imported image 

1  Select the image so that handles display on the 
image, and modify the image as follows: 

■ To scale the image, drag the corner handles. 

■ To move the image, drag it to the desired location. 

■ To keep width and height settings proportional 
while scaling, on the Properties palette, 
select Lock Proportions. 

2  On the Properties palette, specify values for the 
height and width of the image. 

3  If you want to rotate the image, click Modify | Raster 

Images tab ➤ Modify panel ➤ (Rotate). See 

Rotating Elements . 

4  If you want to change the draw order, select the 
image and use the tools on the Arrange panel 
of the Modify | Raster Images tab. 
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The draw order of raster images can be controlled in 
the same manner as detail elements. See 
Sorting the Draw Order of Detail Components . 

 
Related topics 

■ Importing Images . 

■ Deleting Raster Images . 
 

The Manage Images tool lists all raster images in the 
project, including any rendered images that you have 
captured. The tool offers the only way for you to delete an 
image from the project. You cannot remove an image 
from the project by deleting it from a view or a sheet. 

 
To delete a raster image 

1  Click  Insert  tab  ➤ Import  panel  ➤   

(Manage Images). The Manage Images dialog 
lists all raster images in the project. 

2  Select the image name, and click Delete. 

3  Click OK when prompted to confirm the 
deletion. 

Importing Building Components 

Manufactured building components that are formatted 
as Autodesk Exchange (ADSK) files provide design and 
connection data that you can use to accurately place 
the component in a Revit project. These building 
components can be designed in mechanical 

applications, such as Autodesk® Inventor® and used in 
Revit Architecture, Revit MEP, and Revit Structure. 

To open a building component ADSK file, do one of the 
following: 
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Deleting Raster Images 

■   Click      ➤ Open  ➤  (Building  Component). 

■ Click Home tab ➤ Build panel ➤ Component drop-

down ➤ Place a Component. Then click Modify | 

Place Component tab ➤ Mode panel ➤ Load 

Family, select the ADSK file, and place it in the 
project. 

 

Building Component ADSK Files 

A building component ADSK file provides the following 
information to aid in the design process: 

■ Physical appearance of the component in views, such 
as 3D, which lets you determine clearance for accurate 
placement . 

■ Connectors and their placement . 
■ Data about the component, such as its identity data 

 
Opening or loading an ADSK file automatically 
creates a family from the category that is based on 
the Omni Class assignment made on export. 

You can also save the ADSK file as an RFA file (    

➤ Save As ➤ Family), which lets you create a family 

that can be used in multiple projects.. See Revit 
Families for more information about using families in 
Revit Architecture.
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Working with Building Components 

Using a building component ADSK file, you can: 

■ View the component's bounding box at a coarse detail 
level. Connectors will still display in their correct locations 
in the coarse scale view. 

■ View the component’s detailed appearance at fine and 
medium detail levels. 

■ Change the component's graphic display by changing 
the detail level in the project. You can also modify the 
component’s visibility settings in the Family Editor to 
coarse, medium, or fine. 

■ View the component in a 3D, plan, elevation, or section 
view. 

■ Place connectors on the component using the Family 
Editor. See Connectors . 

■ Create new family types from the original component 
by adding new parameters or changing existing ones 
using the Family Editor. 

■ View or change the component's identity data. 

■ Use the component's reference planes or some of its 
geometry for dimensioning. 

■ Tag and schedule the component's parameters. 

■ Render the component. 
Restrictions to using a building component ADSK file 

include the following: 

■ The geometry of the component cannot be changed 
in Revit Architecture. Changes to geometry can only be 
made in the application in which the building 
component was originally designed. 

■ Although the materials assigned in the mechanical 
application are not imported into Revit Architecture, you 
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can assign a material in Revit Architecture that applies to 
the whole component. 

■ Currently, the workflow is only one-way from 
Inventor to Revit Architecture. Inventor cannot open 
ADSK files. 

Tips for Working with Building Components 

Consider the following when working with building 
components: 

■ To optimize model performance in Revit Architecture, 
whenever possible, work with the building component as a 
bounding box at coarse scale. 

■ Because building components can have large quantities 
of detailed geometry, they might take a few minutes to 
open. If opening the component takes too long, or if 
zooming and panning performance is slow, ask its creator 
to further simplify the model prior to exporting. 

■ If the component opens in Revit Architecture with a 
different orientation than expected, either rotate the 
component in the Family Editor or ask its creator to create a 
custom Universal Coordinate System (UCS) and re-export 
the ADSK file using the new UCS. 

■ Use the Autodesk Inventor Translation report to review 
the export results. The report lists the contents of the ADSK 
file. Verify that the model elements were exported as you 
expected. Double-click the ADSK file to open the report in 
your Web browser. 

Building Component Workflow 

The following steps describe a typical workflow for 
using a building component in a Revit project. For 
example, suppose a manufacturer published the 
contents of a rooftop HVAC unit to its website as an 
ADSK file to be used by engineers and architects. 
You want to incorporate this building component in 
your model. Using the component's geometry and 
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data, you can properly place the component in the 
project and also create connectors on it, so the 
component can be used in Revit MEP. 
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Your workflow looks like the following: 

1 Download the building component ADSK file from the  
manufacturer's website. 

2 To open the ADSK file in Revit Architecture, click ... ➤ 

Open ➤  (Building Component). 

NOTE You cannot open ADSK files that are associated 
with a later version of Revit. 

 
3 Load the ADSK file into the project from the Family 

Editor. 

NOTE You can load the ADSK file directly into the project. 

Click Home tab ➤ Build panel ➤ Component drop-

down ➤ Place a Component. Then click Modify | Place 

Component tab ➤ Mode panel ➤ Load Family, select 

the ADSK file, and place it in the project. 

4 Place the component in the project. 

5 Display the component as a bounding box at a coarse 
level of detail. 

6 Display the full geometry at medium and fine levels of 
detail. 

7 View the component in any view. 

8 Run an interference check to ensure proper clearance. 

9 Tag and schedule the component using its parameters. 

10 Dimension the component to its reference planes and 
to some of its geometry. 

11 Create any extra connectors on the component 
in the Family Editor. When they are 
connected to building services in Revit MEP, 
the connectors can be used in flow analysis. 

Opening Industry Foundation Class (IFC) Files 

Revit Architecture opens Industry Foundation 
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Classes (IFC) based on the latest International 
Alliance for Interoperability (IAI) IFC 2x3 data 
exchange standard. (If you open a file that uses an 
earlier standard [IFC 2x or 2x2], Revit Architecture 
supports the format and opens it properly.) For 
information about the IFC file format, see Exporting to 
Industry Foundation Classes (IFC) . 

When you open an IFC file, Revit Architecture creates 
a new file based on the default template. For 
information about selecting the default template, see 
Selecting a Template for IFC Files . 

You can load your own IFC class mapping files and 
override the categories and subcategories for IFC 
objects. 

 

To open an IFC file 

1Click ➤ Open ➤  (IFC). 

2In the Open IFC File dialog, navigate to the 
IFC file to import. 

3Select the IFC file, and click Open. 

Revit Architecture creates a new file based on the 
default template. 

 

Selecting a Template for IFC Files 

1Click ➤ Open ➤  (IFC Options). 

2In the Import IFC Options dialog, click Browse. 

3In the Browse for Template File dialog, 
navigate to the desired IFC template file, 
select it, and click Open. 

4In the Import IFC Options dialog, click OK. 
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Loading an IFC Class Mapping File 

1 Click ➤ Open ➤  (IFC Options). 

2 In the Import IFC Options dialog, click Load. 

3 In the Load IFC Class Mapping File dialog, 
navigate to an IFC class mapping file, 
select it, and click Open. 

4 In the Import IFC Options dialog, click OK. 
 

Overriding Categories and Subcategories for IFC Objects 

1 Click ➤ Open ➤  (IFC Options). 

2 In the Import IFC Options dialog, double-
click in a category or subcategory, and 
enter a new value to override the current 
value. 

As an alternative, you can click Standard to 
reset all values to the standard (default) 
settings. 

3 Click OK, or to save the mappings in a new 
file, click Save As. 

 

Linking AutoCAD Files to a Revit Project 

You can link AutoCAD files to a Revit project. For 
example, you may want to use linked files as follows: 

■ Some team members use AutoCAD to create 
details or elevations, but the rest of the project is 
created using Revit Architecture. You want to 
link the AutoCAD drawings to the Revit project 
and place them on sheets. These drawings can 
then be included in the set of construction 
documents that Revit Architecture generates. 

■ Team members from other disciplines (such as 
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structural engineers or electrical engineers) are 
using AutoCAD to plan their part of the project. 
You want to link their AutoCAD drawings to a 
Revit project to use them as underlays for your 
project views. 
 

For example, the following floor plan shows a linked 
file that will be used as an underlay to trace and 
create structural walls in Revit Architecture. The 
following FIGURE3. 57 

 

 
FIGURE3. 57 

Related topics 

■ Managing Links . 

■ Managing Layers in Linked and Imported Files . 

 

How Linking to AutoCAD Files Works 

When you link an AutoCAD file to a project, Revit 
Architecture maintains a link to that file. Whenever 
you open the Revit project, Revit Architecture 
retrieves the current, saved version of the linked file 
and displays it in the project. Any changes to the 
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linked file are displayed in the Revit project. If the 
linked file changes while the Revit project is open, 
reload the file to retrieve the latest changes. (See 
Managing Links .). 

This ability to retrieve the latest changes to an 
AutoCAD file is the difference between linking and 
importing. When you import an AutoCAD file, Revit 
Architecture uses the version of the file that you 
imported. It does not retrieve or display changes to 
the imported file. 

When you link (or import) an AutoCAD file to a Revit 
project, you can do the following: 

■ Query objects in the file . 

■ Hide or delete selected layers in the file . 

■ Change the graphic display of layers in the file . 
 

When you link a file to a Revit project, you can 
control whether the linked file is visible only in the 
current view, or in all views. As a 2D drawing, the 
linked file is displayed only in relevant 2D Revit 
drawings, such as floor plans. In a 3D view, the 
linked file is displayed as flat, 2D shapes. 
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Linking to an AutoCAD File 

1 Open the Revit project. 

2 If you want the linked file to display only in a 
particular view, open that view. 

3 Click Insert tab ➤ Link panel ➤  (Link 

CAD). 

4 Specify the file to link, as follows: 

■ For Look in, navigate to the location of the 
file. 

■ For File name, specify the name of the file. 

■ For Files of type, specify DWG. 

5 Specify the following options for the linked file: 

a If you want the linked file to display in the 
current view only, select Current view only. 

If you do not select this option, the 
linked file is displayed in all relevant 2D 
views, such as floor plans. 
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b For Layers, select one of the following 
values: 

■ All: Displays all linked file layers in the 
Revit project, including hidden layers. 

■ Visible: Displays visible layers of the 
linked file in the Revit project. Layers 
that are currently hidden in AutoCAD 
do not display in Revit Architecture. 

■ Specify: Allows you to select the 
layers to display in the Revit project 
from a list. After you click Open, Revit 
Architecture displays the list of layers 
from which to choose. 

 

6 Specify the desired import options. 

For details about these options, see Import 
and Link Options for CAD Formats and Revit 
Models. 

7 Click Open. 

8 If, for Layers, you chose Specify, the Select 
Layers/Levels to Import/Link dialog lists the 
layers in the file. Select the desired layers, 
and click OK. 

Unselected layers are not available in the 
Revit project. (However, the layers still 
exist in the AutoCAD file.) 

 
Revit Architecture retrieves the current version of the 
linked file and displays it in the current Revit view. 

 
Related topics 

■ Querying Objects in Layers . 

■ Hiding and Deleting Layers . 
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■ Changing the Graphic Display of Layers . 

■ Managing Links . 
 
 
Location of the Linked File 

Whenever you open a Revit project that is linked to 
a file, Revit Architecture retrieves the current saved 
version of the linked file. The path to the linked file 
displays in the Saved Path column of the Manage 
Links dialog. See Unresolved References . 

If Revit Architecture cannot locate the linked file, it 
displays the path to the version of the linked file 
that it retrieved most recently. Revit Architecture is 
not able to update the link. To reload the linked file 
from a different location, use the Reload From 
function of the Manage Links dialog. See Managing 
Links . 

Use the Path Type column to indicate whether the 
path is absolute or relative. In general, use a relative 
path instead of an absolute path. 

■ If you use a relative path and later move the 
project and the linked file together to a new 
directory, the link is maintained. The new working 
directory becomes the relative path for the linked 
file. 

■ If you use an absolute path and later move the 
project and the linked file to a new directory, the 
link is broken. 

 
Use an absolute path when you link to a workshared 
file, such as a central file that other users need to 
access. This file is likely not to move from its location 
on the disk. 
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Linking DWF Markup Files 

1 Click Insert tab ➤ Link panel ➤  (DWF 

Markup). 

2 In the Import/Link DWF File dialog, navigate to the 
DWF markup file, select it, and click Open. 

The Link Markup Page to Revit Sheets dialog opens. 
Under the DWF View column, the dialog displays the 
sheet view names that are marked up in the DWF file. 
The Revit View column displays the corresponding 
Revit sheet view. If the sheet name from the DWF file 
is the same as the sheet name from the Revit file, then 
the Revit sheet name is automatically filled in the Revit 
View column. 

If the Revit sheet view name changed after it was 
exported to DWF, the Revit View column displays 
<Not linked> next to the DWF sheet view. 

3 If the Revit View value is <Not linked>, select a 
Revit sheet view by clicking the box below the Revit 
View column, and selecting a name from the list. 

You might also do this if you have several other sheet 
views in the Revit file, and you want to apply the 
markups to one of the other sheet views. This would 
make sense only if the other sheet title blocks were 
the same size as the original. 

4 Click OK. 

The DWF markups are placed on the sheet view as an 
import symbol. The markups are pinned, which means 
that you cannot modify their position or copy, rotate, 
mirror, delete, or group them unless they were created in 
Autodesk Design Review. See Modifying DWF 
Markups Created in Design Review . 
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Modifying DWF Markups Created in Design Review 

If markups were created in Autodesk Design 
Review using its markup tools, you can modify the 
Status and Notes properties in Revit Architecture. 
This feature allows you to add information to the 
markup or maintain information about its status. 

 
 

To modify markups created in Design Review 

1 - Select a markup object that was created in 
Design Review. 

 

A markup object might look as follows.in FIGURE 3. 58 . 

 

 

 
FIGURE 3. 58 

 
2 - On the Properties palette, modify the Status 

and Notes properties as desired. 

The changes are saved to the linked DWF file. The 
changes can be viewed in the DWF file by 
selecting the corresponding markup object. 
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Exploding Imported Geometry 

When you import a drawing into Revit Architecture, 
you are importing all the elements, such as blocks 
and external references (xrefs) from the drawing. 
(See Implications of Importing vs. Linking for Xrefs ) 

They are all contained inside a Revit element 
called an import symbol. 

You can explode (disassemble) the import symbol into 
its next highest level elements: nested import 
symbols. This is a partial explode. A partial explode 
of an import symbol yields more import symbols, 
which, in turn, can be exploded into either elements 
or other import symbols. This is analogous to 
exploding in AutoCAD with nested xrefs and blocks. 
For example, you explode an xref into other xrefs 
and blocks. Those xrefs and blocks can, in turn, be 
exploded into more blocks and xrefs. 

You can also explode the import symbol 
immediately into Revit text, curves, lines, and filled 
regions. This is a full explode. 

To explode imported geometry 

1Select the import symbol. 

2Click Modify | <File Name> tab ➤ Import 

Instance panel ➤ Explode drop-down ➤ 

Partial Explode or Full Explode. 

Resulting partial explode import symbols can be 
exploded again by selecting them and clicking 
Partial Explode. You can continue to do this until 
all import symbols are converted to Revit 
elements. 

Managing Layers in Linked and Imported Files 

When you import or link a CAD file to a Revit 
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project, you can query, hide, delete, or change the 
graphic display of layers in the file. 

Querying Objects in Layers 

When you import or link a file to a Revit project, 
you can query the file for information about its 
objects. This allows you to determine the identity of 
an object and the layer on which it resides. You 
can also hide the object’s layer or delete it. 

 

To query objects in layers 

1Open a project view in Revit Architecture. 

2Highlight the import symbol for the file, and 
click to select it. 

When you highlight the import symbol, the 
status bar displays the following: 

<imported file name> : Import Symbol : location 
<Shared> or <Not Shared>. 

3Click Modify | <File Name> tab ➤ Import 

Instance panel ➤  (Query). 

4Select the object to query, as follows: 

■ Move the cursor over the import symbol in 
the view. 

Revit Architecture highlights lower-level objects 
(such as lines) first. Press Tab to switch to 
highlighting of higher-level objects, such as 
blocks. 

■ Watch the status bar. When it 
describes the target object, click to 
select it. The Import Instance Query 
dialog opens and displays the 
following information: 
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■ Type: object type 

■ Block Name: the block that contains the 
object, if applicable 

■ Layer: the name of the layer containing the 
object 

■ Style By: indicates whether the object style 
comes from the layer or by color. 

5To hide the object’s layer 
in the current view, click 
Hide in view. The 
selected layer may still 
be visible in other views. 

 

 View Control Bar. To redisplay the layer, click 

View tab ➤ Graphics panel ➤ Visibility/Graphics. 

On the Imported Categories tab, select the layer, 
and click OK. 

 
6To delete the object’s 
layer from the Revit 
project, click Delete. The 
selected layer is no 
longer visible in any 
project views. 

7To close the Import Instance Query dialog, 
click OK. 

The query editor remains active so that you can 
select other entities. 

8Press Esc to exit the query editor. 
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Hiding and Deleting Layers 

When you import or link a file to a Revit project, 
you may not want all of the file’s layers to be 
visible in Revit Architecture. To control the visibility 
of layers, you can do either of the following: 

■ Hide layers: When you hide layers, they are still 
available to the Revit project, but they do not 
display in views. You can make them visible 
again as needed. 

■ Delete layers: When you delete layers, they are 
not available to the Revit project. (However, they 
still exist in the original CAD file.) If you want to 
restore the layers, you must delete the file and 
either import or link it to the project again. 

 
Related topic 

■ Changing the Graphic Display of Layers . 
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Hiding Layers 

When you import or link a file, you can specify how 
to hide its layers in each Revit view. For example, 
you can display all layers in one view, but hide 
some layers in another view. You can redisplay the 
layers later, if needed. 

If you are not sure on which layer an object resides, 
see Querying Objects in Layers . 

 
To hide layers 

1 Open a project view in Revit Architecture. 

2 Click View tab ➤ Graphics panel ➤  

(Visibility/Graphics). 

3 Click the Imported Categories tab. 

4 In the Visibility column, click to expand 
the DWG file name of the linked or 
imported file. Revit Architecture lists the 
layers in the file. 

5 Clear the check boxes for any layers that you 
want to hide in the current view. 

6 Click OK. 

The layers are hidden in the current view only. To 
redisplay hidden layers, repeat this process and select 
the desired layers. 

Deleting Layers 

When you delete layers in either an imported file or 
a linked file, the layers are no longer available to 
the Revit project. (However, they still exist in the 
original CAD file.) If you want to restore the layers, 
you must delete the file from the Revit project and 
link to or import it again. 

To delete layers in a linked or imported file, use one of 
the following methods: 
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■ When you link or import the file to the Revit 
project, in the Import or Link dialog, for Layers, 
select Visible to display only the layers that are 
currently visible in AutoCAD, or  

select to specify the layers to display in Revit 

Architecture. Any omitted layers are effectively 

deleted. They are not available to the Revit project. 

■ If you want to delete an object in a CAD file, and 
you are not sure on which layer it resides, see 
Querying Objects in Layers . 

■ Delete specified layers, as described in the following 
procedure. 

 
To delete known layers 

1Open a project view in Revit Architecture. 

2Highlight the import 
symbol for the file, and 
click to select it. The 
status bar displays the 
following: 

<imported file name> : Import Symbol : location 
<Shared> or <Not Shared>. 

 

3Click Modify | <File Name> tab ➤ Import 

Instance panel ➤  (Delete Layers). 

4In the Select Layers/Levels to Delete 
dialog, select the layers to delete, and click 
OK. The deleted layers do not display in any 
views in the Revit project. 
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Changing the Graphic Display of Layers 

When you import or link a file to a Revit project, 
you can control the graphic display of each layer in 
the file. For example, you can change the line 
color, weight, and style of the objects. For 
example, when using a file as an underlay, you can 
display the entire file in halftone to distinguish it 
from the Revit model. 
Related topic 

■ Hiding and Deleting Layers . 
 

Preserving or Discarding Graphic Overrides for Linked Files 

When you change the graphic display of layers in a 
linked file, you can specify whether Revit 
Architecture preserves or discards the graphic 
overrides. 

When you preserve graphic overrides, Revit 
Architecture retains any changes made to the 
graphic display of its layers when it reloads the linked 
file. Otherwise, Revit Architecture discards graphic 
overrides when reloading the linked file. This option 
applies to all CAD files that are linked to the project. 

 
To preserve or discard graphic overrides 

for linked files  

1 Open the Revit project. 

2 Click Manage tab ➤ Manage Project panel ➤  

(Manage Links). 

3 In the Manage Links dialog, do either of the 
following: 

■ To retain the overrides, select Preserve graphic 
overrides. 
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■ To discard the overrides, clear Preserve graphic 
overrides. 

4 Click OK. 
 

Making Global Changes to the Graphic Display of Layers 

When you import or link a file to a Revit project, 
you can control the graphic display of file layers in 
all views. 

 
To make global changes to the graphic 

display of layers : 

1 Open the Revit project. 

2 Click Manage tab ➤ Settings panel ➤  (Object 

Styles). 

3 In the Object Styles dialog, click the Imported 
Objects tab. 

4 Click to expand the DWG file name of the file. 
Revit Architecture lists the layers in the file. 

5 For each layer, change the values for Line 
Weight, Line Color, or Line Pattern, as 
desired. See Object Styles . 

6 Click OK. 
 

Related topics 

■ Preserving or Discarding Graphic Overrides for 
Linked Files . 

■ Hiding and Deleting Layers   

 

Making View-Specific Changes to the Graphic Display of Layers 

When you import or link a file to a Revit project, you 
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can control the graphic display of its layers in 
individual views. 

 

To make view-specific changes to the 

graphic display of layers  

1 Open a project view that shows the 

file. 

2 Click View tab ➤ Graphics panel ➤  

(Visibility/Graphics). 

3 Click the Imported Categories tab. 

4 If you want the entire file to 
appear in halftone, select 
Halftone. See 
Halftone/Underlay . 

5 In the Visibility column, 
click to expand the 
DWG file name. Revit 
Architecture lists the 
layers in the file. 

6 To change the graphic display of a visible layer in 
the file: 

a Click the Lines column for the layer, and 
click Override. 

b In the Line Graphics dialog, specify the line 
weight, color, and pattern, and click OK. 

 
7 In the Visibility/Graphic Overrides dialog, click OK. 

 
Related topics 

■ Preserving or Discarding Graphic Overrides for 
Linked Files . 

■ Hiding and Deleting Layers . 
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Troubleshooting Problems with Linked Files 

The following topics describe issues that you may 
encounter when linking files to Revit projects. 

Changes in the DWG File Are Not Reflected in the Revit Project 

Symptom: After linking a DWG file to a Revit project, 
you made changes to the DWG file in AutoCAD. 
However, the Revit project does not display these 
changes. 

Issues and Solutions: This issue can have several 

causes: 

■ The linked file was changed after it was loaded 
into the Revit project, and the Revit project is still 
open. To correct this situation, reload the linked file. 

In Revit Architecture, click Manage tab ➤ Manage 

Projects panel ➤ Manage Links. In the Manage 

Links dialog, on the CAD Formats tab, select the 
linked file in the list, and click Reload. Click OK. 
Revit Architecture retrieves the most recently 
saved version of the linked file and displays it in 
the Revit project. 

■ See How Linking to AutoCAD Files Works . The file 
was imported, not linked. 

When a file is imported, Revit Architecture does not 
retrieve or display changes to the imported file. To 
confirm that the file was linked and not imported, 

click Manage tab ➤ Manage Projects panel ➤ 

Manage Links. In the Manage Links dialog, the CAD 
Formats tab lists all linked files. It does not list files 
that are imported. Therefore, if the file is not listed 
here, then it was imported. 

To correct this situation, go to the view in which 
the imported file displays, select it, and press 
Delete. Then link to the file. See Linking to an 
AutoCAD File . 
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■ Revit Architecture cannot locate the linked file in its 
saved path. 

If the linked file was moved, Revit Architecture 
cannot locate it, and so it cannot retrieve the latest 
saved version of the file. 

 To reload the file from a different location, use the 
Reload From function of the Manage Links dialog. 
(See Managing Links .) 

 

Changes to the Layer Color and Line Style Do Not Display in the Revit 
Project 

Symptom: You made changes to the graphic display 
of layers in the linked file. After the linked file was 
reloaded into the Revit project, these changes 
disappeared. 

Issue: To save changes to the graphic display of 
layers in linked files, select the Preserve Graphic 
Overrides option on the Manage Links dialog. If this 
option is not selected, Revit Architecture discards 
graphic overrides when the linked file is reloaded. 

Solution: See Preserving or Discarding Graphic 
Overrides for Linked Files . 

 

Layers in the DWG File Do Not Display in the Revit Project 

Symptom: Some layers in the linked file do not 
display in the Revit project. 

Issue: The layers may be hidden or deleted. 

Solution: To determine whether the layers are hidden 

or deleted, click View tab ➤ Graphics 

panel ➤ Visibility/Graphics. On the Imported 

Categories tab, click to expand the DWG file. Revit 
Architecture lists the layers in the file. 

Layers that are not listed here have been deleted; 
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they are not available to the Revit project. If you 
want to restore the layers, you must first delete the 
linked file and then link it to the project again. 
When linking, be sure that for Layers, you select All 
or Select. See Linking to an AutoCAD File . 

If the Visibility option for a layer is cleared, the 
layer is hidden in the current view. To display the 
layer, select the Visibility option, and click OK. 
Revit Architecture displays the layer in the current 
view. 

File Operations (Open, Save, Synchronize) Are Blocked or Slow 

Symptom: In some cases, Revit cannot open, save, or 
synchronize with files. 

Issue: Some antivirus software solutions lock files, 
preventing other applications from accessing them. 

Solution: You or your network administrator can 
define the following file extensions as exceptions in 
your antivirus filter. 

■ Revit Projects (RVT) 

■ Revit Families (RFA) 

■ Revit Templates (RTE) 

■ Autodesk Design Package (ADSK) 

■ Industry Foundation Classes (IFC) 

■ AutoCAD drawings (DWG) 

■ CAD Data Transfer (DXF) 

■ MicroStation drawings (DGN) 

■ ACIS models (SAT) 

■ SketchUp drawings (SKP) 

■ Images (BMP, JPG, and PNG) 

■ Data (RWS and DAT) 
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